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SKYLINEGLOBE SERVER V7.0.1 – GETTING STARTED 

 

SkylineGlobe Server is a private cloud solution that provides a comprehensive set of web 

services for publishing, storing, managing and streaming 3D spatial data. SkylineGlobe Server 

provides streaming services for all your spatial data types including terrain (MPT/TBP), map 

(raster-WMS/WMTS), feature (WFS/WFS-T), 3D Mesh (3DML, 3D Cesium tiles), and point cloud 

(CPT, 3D Cesium tiles). All data on your server is cataloged and referenced so clients can easily 

find the specific published layer required. Your data is kept safe by multiple security layers, 

including restriction of each user group to predefined data folders and a robust user 

authentication mechanism.  

SkylineGlobe Server can be configured as a single server or as part of a new or existing server 

cluster. A server cluster is a collection of servers that communicate with each other in order to 

serve data to clients with higher availability. In order to communicate, all servers in the cluster 

must share a common configuration database that is located on a shared drive and have required 

permissions to all folders that are used by SGS to share data or store cache files. 

Individual geospatial layers and complete projects can be directly uploaded and published to the 

cloud server from TerraExplorer or other Skyline client applications, thus streamlining your 

workflow and eliminating the need for any server side login after initial installation. Through a 

single publishing operation, data is made ready for consumption by all TerraExplorer clients: 

Desktop, Mobile, and TE for Web, as well as standard geospatial applications. Server-side 

geospatial layers that are stored in existing data stores on the server can also be published by 

scanning their data stores and publishing selected layers.  

The server’s built-in complete user access control system allows easy management of users, 

groups, and administrative roles controlling the server-side storage and client-side read/write 

permissions.  

Based on Microsoft IIS Server, SkylineGlobe Server repackages the retired TerraGate and SFS 

products into a unified server technology and management interface from which to control and 

manage the complete 3D geospatial data lifecycle. 

What’s New in SkylineGlobe Server v7.0 

SkylineGlobe Server v7.0 introduces the first release of the overhauled server side component of 

Skyline. It features the all-new packaging of the TerraGate and SFS components into a unified 

server technology and management interface. In addition to streaming, managing, and storing 

data, SkylineGlobe Server also supports direct publishing to the server from Skyline applications. 

As a result, clients require only web access to their cloud server after initial installation and 

configuration is complete. 

The new server supports the main services provided by the retired/previous TerraGate 

components including terrain (MPT/TBP), map (raster-WMS/WMTS), feature (WFS/WFS-T), and 

3D Mesh (3DML). In addition, a new point cloud service has been introduced for managing and 

serving multi-resolution and stream-optimized point cloud data. The new point cloud service and 

improved 3D mesh service also expose 3D Cesium tiles for TerraExplorer for Web and Cesium 

based clients.  
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The licensing process has been streamlined by a new client-side implementation that unlocks 

advanced API capabilities while connected to a terrain database from SkylineGlobe Server, 

replacing the former TerraGate Internet License Service. Also note that TerraGate’s Collaboration 

Service has been phased out of SkylineGlobe Server, but is still available when required for 

backward compatibility. For information, contact support@skylinesoft.com.   

New Features in SkylineGlobe Server 7.0.1 

 

New Support for Transactions 

SGS 7.0.1 supports transactions on GeoPackage file, and Oracle and Postgre databases, 

allowing editing of server-side feature layers.   

Auto-Scanning of Server-Side Folders   

Data sources can be periodically scanned for changes and SGS automatically updated 

accordingly: new layers are added, deleted layers are removed, and modified layers are updated 

in SGS. 

Customized Authentication Layer  

Ability to develop customized authentication DLL overriding the SGS internal user/pass 

authentication mode. This customized DLL can be used for PKI/Active-Directories based 

authentications 

Efficient Management of Unused Resource Files  

Easily identify and delete all files stored in SG Upload data sources that are no longer referenced 

by SGS layers. 

Improved Management of Deleted Layers  

With one click, you can display a list of all deleted layers on the server and relevant information, 

and select which layers to restore and which to permanently delete.  

Management of TE4W Settings  

The new release supports full management (creation, editing, loading and saving) of multiple 

configuration files.   

Cache Management Improvements 

New option to prevent creation of a cache file for any layer – SGS serves all client requests 

according to the most recent layer information.  

Bug Fixes and Stability  

This release improves overall stability and performance. 

mailto:support@skylinesoft.com
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Product Capabilities 

 Streaming Services 

 Terrain – MPT and TBP (Using DirectConnect) 

 Maps (Raster) – WMS, WMTS 

 Feature – WFS, WFS-T 

 3D Mesh – 3DML and 3D Cesium tiles  

 Point Cloud – CPT and 3D Cesium tiles  

 Projects – TerraExplorer Desktop, Mobile and Web project files 

 Upload and Catalog Services 

 Data upload and storage – Upload and publish geospatial layers and complete projects 

from TerraExplorer or other Skyline client applications. 

 Advanced cataloging – Automatic and manual extraction of metadata and geospatial 

information.  

 Search queries – Advanced client-side search options for data layers and projects. 

 Web Manager – Management of all services, catalog database and user permissions from a 

Web interface. 

 Direct Uploading to SkylineGlobe Server – From the following clients: 

 TerraExplorer Pro 

 Upload all feature layers (including KML), raster layers, 3DML and CPT layers. 

 Upload all resources (data folder). 

 Upload and automatically convert project file for TE for Web and TE for mobile clients. 

 PhotoMesh (* Requires PM v7.2) 

 3D model (3DML) 

 Point cloud model (LAS) 

 Raster layers (Orthophoto, DTM, DSM) 

 CityBuilder (* Requires CB v7.2) 

 3D model (3DML) 

 Publish TerraBuilder output / projects (* requires TB v7) 

 Authentication Mechanism 

 Only registered users can upload data. 

 User uploads data to predefined data folder. 

 Each data layer has a view/edit access level (None, Only Me, My Group, or Everyone). 

 Divide users according to groups. 

 Server Clusters 
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 Multiple SGS servers managed behind a load balancer. 

 All transactions are stateless (can switch from one server to the other). 

 Centralized management of all your servers.   

 

SkylineGlobe Manager Main Page 

Software and Hardware Requirements 

Operating 
System 

Windows® Server 2008 R2 / 2012 R2 - 64 bit. 

System Memory 4GB of RAM (8 GB or more recommended).  

Processor Dual-Core (4 or 8 cores recommended). 

Browser Microsoft Internet Explorer 9 or higher. 

User Privileges Administrator privileges required for installation and configuration. 

Additional 
Software 

Microsoft Internet Information Services IIS7.5, IIS8.5, IIS10 with .Net 
4.0. 
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SkylineGlobe Server Installation 

To install SkylineGlobe Server: 

Note: On some operating systems, administrative privileges may be required. 

Note: If you want to secure SGS, it is recommended to enable SSL on the SkylineGlobe Server 

site before installation. After installation, modifications to SGS security are performed by 

manual editing of the Web.config file in the installation folder. See: “Managing SGS 

Security” in this chapter for more information. 
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Note: SGS requires Microsoft Internet Information Services IIS7.5, IIS8.5, or IIS10 with .Net 

4.0, and the following components. 

 

8. Place the SkylineGlobe license files (SLSkylineGlobeServer.lic) next to the 

SkylineGlobeServer.exe file in the installation folder.  

9. Double-click the SkylineGlobe.exe file. If you are installing SGS and do not have Internet 

Information Services, a dialog box is displayed informing you that you must first install IIS. 
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Install IIS and restart the installation process. The SkylineGlobe Setup dialog box is 

displayed. 

 

SkylineGlobe Setup 
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10. Click Next. The End-User License Agreement is displayed. 

  

End-User License Agreement 

11. Read the License Agreement and then select the I accept… check box. 

12. The Server Configuration Database Folder dialog box is displayed. 
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Server Configuration Database Folder Dialog Box 

13. Select one of the SkylineGlobe Server configuration database options. The option selected 

depends on the reason for this installation:  

 If you are installing a new server with a new database – Select Create a new database. 

This option applies whether you are installing a new single, standalone server or 

installing a server that will be part of a new server cluster. When creating a new server 

cluster, the configuration database must be located on a shared drive to which all servers 

in the cluster have read-write access.  

Note: If you are creating a new server cluster, you will require a known database 

security token that can be shared with all computers in the cluster to enable them 

to use the database. This token can be generated after installation in SGS 

Manager.  

 If you are creating a new server that will be part of an existing server cluster (and 

therefore use the cluster’s existing database) – Select Choose an existing database, 

and then enter the security token that was generated for this database.  

 If you are creating a new server using a backup database – Select Choose an existing 

database, and then enter the security token that was generated for this database.  

 If you are upgrading an existing server installation for the same IIS user – Select 

Upgrade your existing database. 

14. Browse to the location of the new or existing database. 

Note: When working with a server cluster, the database must be located on a shared 

drive that has Modify permission and is accessible from all servers. 
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15. Click Next. The IIS Application Pool Identity dialog box is displayed. 

 

IIS Application Pool Identity Dialog Box 

16. Select a Windows user account for the IIS application pool.  

Note: If you are upgrading an existing server installation, make sure to use the same IIS 

application pool identity as used in the previous installation 

17. If using a custom account, enter the User Name and Password.  

18. Click Next. The Destination Folder dialog box is displayed. 
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Destination Folder 

19. If you want to select a different folder than the default for the SkylineGlobe Server installation, 

enter the required folder path or click Browse, and browse to the required folder.  

Note: The installation folder should be located on the local drive.  

20. Select an IIS Site. 

21. Type an Application Alias. 
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22. Click Next. The HASP Run-time dialog box is displayed. 

  

HASP Run-time 

23. If you want to install HASP Run-time, select the check box.  

24. Click Next. The Ready to install SkylineGlobe dialog box is displayed. 
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Ready to install SkylineGlobe 

25. Click Install. If the application pool user account does not have the necessary permissions to 

the configuration database folder, a dialog box is displayed asking if you want to add the 

permissions. Add the necessary Modify permission to the folder for the application pool user 

account, and click Retry. If you want to add permissions after installation, click Ignore to 

complete installation.  

 

IIS User Access Permissions Dialog Box 
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26. The TerraBuilder Fuser InstallShield Wizard is displayed. 

 

TerraBuilder Fuser InstallShield Wizard 

27. Click Next. The License Agreement is displayed. 
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TerraBuilder Fuser License Agreement 

28. Select the I accept… option and click Next. The Customer Information dialog box is 

displayed. 
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Customer Information 

29. Type your User Name and Company Name. 

30. Select who to install this application for, and click Next. The Choose Destination Location 

dialog box is displayed. 
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Choose Destination Location 

31. Browse to the Destination Folder, and click Next. 

32. In the dialog box that is displayed when the installation process is complete, click Finish to 

exit the wizard. 

Post-Installation Procedures 

The following are post-installation procedures: 

 Adding Access Permission for the SGS Installation Folder 

 Managing SGS Security 

 Running TerraBuilder Fuser 

 Setting a Public URL 

 Importing Configuration Files from TerraGate and SFS 
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Adding Access Permission for the SGS Installation Folder 

If the SkylineGlobe Server installation was unable to automatically add access permission for the 

SGS installation folder and other folders that may be used by SGS to share data or store cache 

files, you must manually add the necessary Modify permission to the folder for the application 

pool user account for these folders.  

Note: The Windows user account used by SGS appears in the Settings page in the General 

Settings section. By default, the installation folder of the SGS is C:\inetpub\wwwroot\SG. 

Managing SGS Security 

If your site security is changed after installation, modifications to SGS security are performed by 

manual editing of the Web.config file in the installation folder. 

To modify SGS security: 

1. Open the Web.config file located in the application’s installation folder. 

2. Search for all instances of “http mode” and “https mode”: 

a. Remove the comment code from the protocol version that you want to enable 

b. Comment out the protocol version that you want to disable. 

3. On the Settings page, in the General Settings section, modify the Public URL in accordance 

with your security mode (i.e., http:// or https://). 

For example, if enabling HTTPS, the required code changes in the Web.config file will include the 

following: 

From: 

<!--http mode--><endpoint address="mexwebhttp" binding="mexHttpBinding" contract="IMetadataExchange" /> 

<!--https mode--><!--<endpoint address="mexwebhttp" binding="mexHttpsBinding" contract="IMetadataExchange" 

/>--> 

To: 

<!--http mode--><!--<endpoint address="mexwebhttp" binding="mexHttpBinding" contract="IMetadataExchange" 

/>--> 

<!--https mode--><endpoint address="mexwebhttp" binding="mexHttpsBinding" contract="IMetadataExchange" /> 

Running TerraBuilder Fuser 

One TerraBuilder fuser is installed on each server computer as part of the installation process. 

See: “SkylineGlobe Server Installation” for information. The fuser is an application that allows 

SkylineGlobe Server DirectConnect to utilize the resources of the computer, on which it is 

running, for the on-demand generation of a virtual 3D terrain database defined by the 

TerraBuilder project file (TBP). While fusers are only required for serving TBP, it is always 

recommended to run the fuser on each server computer.  

Setting a Public URL 

After installing SkylineGlobe Server, a public URL should be set, i.e., the URL that should be 

used from client computers to connect to the server. By default, the public URL is set to 

http://<SG Server>/SG where <SG Server> is the IP or name of the machine on which 



 

 

 20 

 

SkylineGlobe Server is installed. In some cases, this URL may not be correct, and therefore 

should always be verified post-installation.  

Note: If the site is secured use https instead of http. 

To set your server’s public URL: 

1. From the SkylineGlobe Server menu, select Settings. The Settings page is displayed. 

2. In the General Settings section, enter the required Public URL. 

3. Click Save. 

Migrating TerraGate and SFS to SkylineGlobe Server 

Migration from TerraGate and SFS to SkylineGlobe Server is performed by importing 

configuration files from TerraGate and SFS to SkylineGlobe Server Manager. All data sources 

defined in these files are automatically scanned, and their layers added to SkylineGlobe Server.  

In addition to migration, there are also techniques to enable SGS to handle requests that were 

previously handled by TerraGate and SFS. This rerouting of requests entails the following 

additional steps: 

 Binding of the IIS site where SkylineGlobe is installed to the same IP’s and ports that 

TerraGate was previously bound to and unbinding of TerraGate from them. 

 Configuration of the URL Rewrite to reroute requests. 

See: “Migrating TerraGate/SGS to SkylineGlobe Server” in the SkylineGlobe Server User Manual 

for more information.  

Step 1: Starting SkylineGlobe Server Manager 

To start SkylineGlobe Server Manager: 

1. Do any of the following: 

 Open a web browser and browse to http://<SG Server>/SG where <SG Server> is the IP 

or name of the machine on which SkylineGlobe Server is installed.  

Note: If the site is secured use https instead of http. 

 If working directly on the server computer, open a web browser and browse to 

http://localhost/SG.  

 Click the SkylineGlobe Server Manager desktop shortcut. 

The SkylineGlobe Server Manager Login page is displayed. 

http://localhost/SG
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Login Page 

2. Enter your user name and password in the respective fields. 

The default User Name and Password after installation are admin and admin (lower-case). 

The Change default administrator password page is displayed. 

 

 

Login Page 

3. Enter a new password for the admin user. The Main page is displayed. 

Note: Additional users can be added from the Users page. A user with an Editor role is 

required to allow publishing from TerraExplorer Pro. 
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Main Page 

Step 2: Connecting TerraExplorer Pro to SkylineGlobe Server 

To connect TerraExplorer Pro to SkylineGlobe Server: 

Note: Working with SkylineGlobe Server requires TerraExplorer Pro v7.0 and above. 

1. Start TerraExplorer Pro and open a Project (FLY). 

2. On the Layers tab, in the SkylineGlobe group, click Disconnected. The SkylineGlobe 

Server dialog box is displayed. 
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Connect to SkylineGlobe Server 

3. Enter the connection information defined above and click Connect. 

Use the following format: http://<IP>/SG 

where <IP> is the IP or name of the machine on which SkylineGlobe Server is installed.  

Step 3: Publishing Data from TerraExplorer Pro 

To publish data from TerraExplorer Pro to SkylineGlobe Server: 

1. Add to your TerraExplorer project the content you want to publish. 

2. On the Home tab, in the Project group, click Publish to SG. The Publish to SkylineGlobe 

dialog box is displayed. 

Note: You must first save the project to a regular .FLY file before publishing to the 

server.  
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Publish to SkylineGlobe 

3. Set the View access for the project.  

4. Set the Edit access for the project 

Note: All uploaded feature layers are converted to Geopackage (.gpkg) files, allowing 

layer transactions from TerraExplorer Pro any WFS-T client. 

5. Click Publish. For more information about publishing options, see the “Working with 

SkylineGlobe Server” chapter in the TerraExplorer User Guide. 

Note: The published data is saved in the upload data source defined for the currently 

logged in user’s group (default value: “DefaultUploadDataSource”).  

6. When the publishing is complete, click OK. The Open published project dialog box is 

displayed, showing the URL’s for the desktop, mobile, and web projects. These URL’s enable 

you to open the TE Web or TE Desktop projects from your browser. 

Note: The TE Desktop project can also be opened from the TerraExplorer File menu. 
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Open Published Project 

7. If you want to currently open the published TE Desktop project from SkylineGlobe Server, 

click Yes.  

Step 4: Publishing Existing Files on the Server  

To publish existing files on the server: 

1. Create a folder on the server machine or locate an existing one. 

2. Add to the folder all the files you want to publish. Any of the following file types can be 

published: feature layers, imagery and elevation raster layers, 3DML, and CPT. 

Note: Verify that the Windows user account used by SGS has access permissions to this 

folder. The Windows user account used by SGS appears in the SkylineGlobe 

Server Manager Settings page in the General Settings section.  

3. If the user account does not have access permissions, do the following: 

a. In Windows Explorer, right-click the folder and select Properties. 

b. On the Security tab, click Edit. 

c. In the dialog box that opens click Add, and type the Windows user. 

d. Click Check Names, and then click OK. 

e. In the Permissions for <folder name> dialog box, in the Permissions for System 
section, select Full Control.  

f. Click OK. 
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4. Open SkylineGlobe Manager, and from the menu, select Data Sources. 

5. Click Add, and enter the following parameter values: 

a. Name: ScanSourcesFolder 

b. Data Source Type: SG Scanner 

c. Path: <the path from step 5.1> 

d. View Access: Everyone  

e. Click Connection Status and verify that it changes to OK. 

Note: If connection status verification fails, check that you performed step 3 correctly.  

f. Click OK. SGS scans the data source and displays a list of all files found.  

6. Select the check box of each of the sources you want to add to SkylineGlobe Server, i.e., the 

files you added to the folder, and click OK. 

7. Start TerraExplorer Pro, and then on the Layers tab, in the SkylineGlobe group, click Load 

Layers. In the SkylineGlobe Layers dialog box that is displayed, select the required layers, 

and click Load. 

Note: You can use CTRL-click or SHIFT-click to multi-select layers. 

Step 5: Configuring TerraExplorer for Web (TE4W) and Loading SGS Data  

TerraExplorer for Web can have custom configurations that define various elements of your 

TE4W application including which layers TE4W can connect to, your website subdomains, screen 

overlay logo, copyright text, and search provider. These TE4W elements are configured in the 

TerraExplorer for Web Settings section of the SkylineGlobe Server Manager Settings page. 

Multiple customized configurations can be set. 

To customize your TerraExplorer for Web application and open your published project: 

1. From the SkylineGlobe Server menu, select Settings. The Settings page is displayed. 

2. In the TerraExplorer for Web Settings section, select the required configuration and click 

Edit. The TerraExplorer for Web Settings dialog box is displayed. 

3. Modify the settings as required: 

4. Click Save.  

5. To open TE4W, in your browser, browse to 

http://[www.yourdomain.com]/sg/TerraExplorerWeb/TerraExplorer.html. 

6. To open another project in TE4W, from the Options  menu, select Open Another 

Project, and then select your project from the SkylineGlobe Layers list and click Load. 

7. If you want to add layers to your project, do the following: 

a. On the Contents pane, click Layers , and then click Load Layers. The SkylineGlobe 
Layers dialog box is displayed. 

b. Search for the required layers. Click Search. Your search results are displayed in the 
search results list at the bottom of the page.  

c. Select the layer you want to load, and click Load Layer. 
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Step 6: Publishing a DirectConnect Project  

In order to publish a DirectConnect project to the server, a TerraBuilder DirectConnect project 
must be created and then added to SkylineGlobe Server by defining a data source that defines 
connection information to its folder.  

To configure a data source for DirectConnect projects on the server: 

1. Install TerraBuilder v6.6.1 on the server machine. 

2. In TerraBuilder, create a new project in which you insert imagery and elevation layers. 

3. On the Home tab, in the Create group, click Publish and select Prepare for Publishing. 

The Creating Resolution Pyramids dialog box is displayed. 

4. When conversion is complete, click OK. 

5. Save the TerraBuilder project. 

6. Open SkylineGlobe Manager, and from the menu, select Data Sources. 

7. Click Add, and enter the following parameter values: 

a. Name: ScanDC 

b. Data Source Type: SG Scanner 

c. Path: <the path to the TerraBuilder project created in step 6.2> 

d. View Access: Everyone  

e. Click Connection Status and verify that it changes to OK.* 

f. If connection status verification fails, do the following: 

i. In Windows Explorer, right-click the folder and select Properties. 

ii. On the Security tab, click Edit. 

iii. In the dialog box that opens click Add, and type the Windows user. 

iv. Click Check Names, and then click OK. 

v. In the Permissions for <folder name> dialog box, in the Permissions for System 

section, select Full Control.  

vi. Click OK. A dialog is displayed showing all importable layers (in this case, the 

TerraBuilder project). 

8. Select the check box of each of the sources you want to add to SkylineGlobe Server, i.e., the 

TBP, and click OK. 

9. Start TerraBuilder Fuser (installed with TerraBuilder). 

10. Start TerraExplorer Pro, and then from the File menu point to Open and select Open 

Project from SkylineGlobe. 

11. Select the TBP and click Load. 


